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(@ TUUMaMUSMIoanwisdasusasiin. X @ suumsiusmseonvilsdosusasin. X +

(uSusovdldnnsaldng

< C' | & https://edidftgoth

s_:_uumslu§msaemias‘;‘usour_i"nu ‘p::*a

luSusavdidnnsaiind 7o Joyadldnnsolnap
fonouddoaunumosouooN3lususavdldnnsadnd gooonlas
Alkusmiseanlususoo (Certification Augkority : CA) il
WUs:noussnssud1og Wwiudutnasidaaisniuloldsiuana
k3o aUnsnilnsodie 1u|Web Server|armnsdadedaosi s e, :i
doauosy lavordainalulagnisensy inalulaglasvasionugiu — S:uisliustiseeniiicaesusoojuItREn
noyuoaisisus (Public Key - Infrastructure - PKI) awisn ‘
hulslumsavarslododdaea (Digital Signature) k3o ms

1IsKia noaska (Encryption) [a 1ignszusumsidnsia
(daya + Digital Certificate)

o ¥ o 3 - o o™ T 3 = =
@ suumMamusmesanwisdasusasay X ® suumsliusmsoanwiledasusesan X +

< C | A Notsecure | edidft.goth

awisnavnasvalgusnisliaoinovansooniususoy (Certification

Auhthorly - CA) nTosumwuumanaua:lCJUHuaamLunloaﬂ asiodosIEnnsaiing

luSusevadaoalulasoms Paperless nsugamns laur Digital Signature

« TOT CA a9 usén iloi o1Ma (LKiBu) Qs1oazidualan
15uls@ http://www.ca.tot.co.th R A

e CATCA s@n nan Insauuiau d1a (UKIBU) O S

g Uah\': l:su A P Al T uKIgu) q awilodadiannsatndiivly
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sUuuu Certificate

sduuu

s18asldya

wuu CD

dayalususooa lusUuuu Digital File cwuiasgiu
PKCS#12 ua:Uuiinasuuusiu CD dsiaiu
(Password) ialaofiumsdadouazldoiu uazdoodado
lususood asluindaonoumolaasidaomsloiu awsn
Export doyanmyuodoudo (Private Key) aononlWala

uuu USB Token

doyanmyuos (Key Pair) gnaswsumsluds USB
Token cnuasgiu PKCS#11 1Ju USB Token @usu
samsiu Digital Certificate ua: PKI rivdu Tiawnsn

Export dayanmyuodoudd (Private Key) aanownda
USB Token la sooSumsiouds USB 1.0 - 2.0

uvu Smart Card

doyanmyuos (Key Pair) gnaswdumsludodas Smart
Card cmwuasgiu PKCS#11 Microprocessor-Based
Smartcards liawuisn Export dayanmyuodoudd
(Private Key) aanoindasla

JoQ/doldy

- iskasiu (Password) iladasiumsdadoua:
15o1u

- davdadolususavd asluindaonaumolaasi
doomisldolu

*** Junvunisuldnumniga

- iskasiu (Password) idadaonumsldolu
- ilnowdaaansgy azasnlumswnm

- isndudasiiindasadru (Reader)

- Tisndudasdadolususood inomslBou

- iskasiu (PIN Code) inadaofiumsidoau
- Tisndudasdadolususood inomslEou

- 3nludosldonusounuindovsrulias
(Smartcard Reader)

- Iaowdaaansdo
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dadv Plug in & suavareidododldnnsolng

aroulkaa Plug-in oani3ulsd
http://edi.dft.go.th/download/SignNutCom.zip

Click this button to install SignMutCom software to the spedfied destination

SignNutCom Setup = e

rDirectory:
C:'\Program Files\SignMutCom Change Directory

Exit Setup

% Welcome to the SigniautCom instalation program.
-

Setup cannot install system fles or update shared files if they are in use.
Bafore proceadng, we recommend that you dose sny BppECEtons you may
be nunning,

SignMNutCom Setup was completed successfully.
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Foold Microsoft Internet Explorer imdul dotnaoin icon aeautdnlusunsy

Microsoft Edge Google Chrome Opera

T_l
(5

; ;
Cceeo
. ; ;

Microsoft Edge Firefox Safari
Chromium
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nKuaninolulaoanauoy Internet Explorer

frkuadlu Compatibility lasaann icon sutkeo 1donaann Compatibility View settings
Nuw “dft.goth” naosnandu Add

ALY | | Search..

m Winanddqanins  dayauasennilii

- O b4
o~ | P - X Compatibility View Settings *
Print »
File > [ l/_\h Change Compatibility View Settings
Zoom (100%) > |2 ﬁ
Safety >
Open with Microsoft Edge Ctrl+Shift+E Add this website:
Add site to Apps | dft.qo.th I Add
View downloads Ctrl+J
Manage add-ons Websites you've added to Compatibility View:
Remawve

sWalnsHasaan - i

F12 Developer Tools
Go to pinned sites

B ELRIT

Internet options

| About Internet Explorer

1‘?“" Q

UaIHIILS NS
el

[+*] Display intranet sites in Compatibility View
[Juse Microsoft compatibility lists

Learn more by reading the Internet Explorer privacy statement

szae a1 Fuil 5 wguanau 2560

***i1plusinsy Internet
Explorer Gmisewian
nosasooaau Compatibility
View doy
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nKuaninolulaoanauoy Internet Explorer

frkuad{u Internet options lasaann icon sUileo udonann Internet options

>
ix @

QI%\|0 http://edi.dft.go.th/ - | | Seaich.. D~

! @ svunsliuiaeoanmifadis.., ¥ ||_ﬂ Print ’ *
= e File » [T
B\ - wig i - e Zoom (100%) > | A
3 s:uun1slhu§msaannﬁuaasusa\mun1u@ ; Safety ° >
DFr | Winandidanins  dayanasen iy Ope“-"‘"‘h - e
Add site to Apps
View downloads Ctrl+1

Manage add-ons

F12 Developer Tools
sadnseaeaan - i : Go to pinned sites
| | Compatibility View settings
SWdsiu

Whgwuy

wingazu (Wilsznaiunns)

usahinau
"nsa11d Internet Explorer windu" "@

unugauaiaNuiswals [ liffswalanaessuinns
d@daudnisaisansvilssina
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nKuaninolulaoanauoy Internet Explorer

Tools > Internet Option > Security
Trusted sites > *.dft.go.th

Internet Options 7 [ Trusted sites x

1

™

G | Security  pri Content  Connecti Pri Advanced
Enera e B ennecens LLCuE van J ou can add and remove websites from this zone, All websites in

this zone will use the zone's security settings.

Select a zone to view or change security settings.

0 * , ® Add this website to the zone:

* dft.go.th | [ Add
Internet  Localintranet Trusted sites  Restricted
sites Websites:
) e wemor
This zone contains websi you *

trust not to damage your computer or . dft. go - th

your files,
You have websites in this zone.
Security level for this zone

[Jrequire server verification (https:) for all sites in this zone

Custom

Custom settings. m
-To change the settings, dick Custom level,
-To use the recommended settings, dick Default level.
[JEnable Protected Mode {requires restarting Internet Explorer) 6
. Customlevel... | Defaultlevel |
| Resetall zones to defaultlevel |
ok || Cancel | Aply
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nKuaninolulaoanauoy Internet Explorer

Tools > Internet Option > Security
Custom level > Initialize and script ActiveX control > Enable

Internet Options ? > [ Security Settings - Trusted Sites Zone > :I
[l General Security Privacy Content Connections Programs  Advanced Settings
(") Enable M
Select a zone to view or change security settings. . O Prompt
\#| Initialize and script ActiveX controls not marked as safe for s
@ ¢ v O P
[(Of Enable
Internet  Local intranet Trusted sites  Restricted ) Prompt
ite :
stes \#| Only allow approved domains to use ActiveX without prompt

Trusted sites (®) Disable
f This zone contains websi t you () Enable

t':jrt El‘étsto damage your computer or |#| Run ActiveX controls and plug-ns
¥ ) () Administrator approved
() Disable
Security level for this zone (@ Enable
D Prompt
Custom |#| Run antimalware software on ActiveX controls v
Custom settings. < (@) rie=hla s
-To change the settings, dick Custom level,
- To use the recommended settings, dick Default level, *Takes effect after you restart your computer
Reset custom settings
[1Enable Protected Mode {requires restarting Internet Explorer) Reset to: |I'"I jium (default) - | | Resat... |
"jcusmm level... || Defautlevel |
9 | Reset all zones to default level | | K | | cancel |




adoluSuseavdldnnsatnd (Digital Certificate)

dado Root certificate voorlFUSMS .

-
Certificate — -

Mame

5] cacert.crt

[ NEW TECHNOLOGY.pfx

Type

Security Certificate

Perscnal Information Exchange

-
Certificate Import Wizard ’
e e——

General | Details | Certification Path

|_a Certificate Information

This certificate is intended for the following purpose(s):
» Allissuance policies
» All application policies

Issued to: CAT Root CA

Issued by: CATRootCA

valid from 3/ 25/ 2007 to 3/ 28/ 2027

Issuer Statement

Learn more about £

Lo |

i

-
Certificate Import Wizard »
e sl

| -

Welcome to the Certificate Import
Wizard
This wizard helps you copy certificates, certificate trust

lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

Certificate Store
Certificate stores are system areas where certificates are kept.

Certificate Import Wizard

Select Certificate Store

Windows can automatically select a certificate store, or you can spedfy a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
(@) Place all certificates in the following store
Certificate store:

Learn more about certificate stores

Browse.. e

Select the certificate store you want to use.

| Personal -
i Trusted Root Certification Authorities H
| Enterprise Trust

7] Intermediate Certification Authorities

17 Trusted Publishers
" Untrusted Cartifirates
4 I | »

[ Show physical stores

[ ok [ cancel |

o

<Back || Mext> | [ cancel

< Back Next > | [ Cancel
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dadolususevdldnnseatnd (Digital Certificate)

—
—

adio Root certificate yvoor(FUSS

- - - Certificate | J
Certificate Import Wizard » u Certificate Import Wizard » M
_— —_— General | Details | Certification Path

Certificate Store

Completing the Certificate Import

Certificate stores are system areas where certificates are kept.

Wizard | R Certificate Information

The certificate will be imparted after you dick Finish. - - . _
Windows can automatically select a certificate store, or you can specify a location for This certificate is intended for the following purpose(s):
the certificate. * Allissuance policies

You have spedfied the following settings: * All application policies

() Automatically select the certificate store based on the type of certificate o e R N Trusted Root Certifice

@ Place all certificates in the following store Content Certificate

Certificate store:

Trusted Root Certification Authorities Browse. ..

Issued to: CAT Root CA

Certificate Import Wizard | S

@ The import was successful,
Learn more about certificate stores

4 i
QK |JEI' Statement ’
<gack || Finish Cancel /

4 i k

Leart, ’,

<Back || Mext= Cancel

L = —— y E——— - = 3 —

[ ]

a
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dadolususevdldnnseatnd (Digital Certificate)

-
=

Qdv

0 Certificate yaousyn

-
Certificate Import Wizard

==

Welcome to the Certificate Import
Wizard

Thig wizard helps you copy certificates, certificate trust
lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

< Back MNext = Cancel

Marne Type

5] cacert.crt
3} NEW TECHNOLOGY. pfx

Security Certificate

Perscnal Information Exchange

===

=
Certificate Import Wizard -

-
Certificate Import Wizard -

File to Import
Spedify the file you want to impart.

File name:

C:\Wsers\WAIO \Desktop'cert\NEW TECHNOLOGY . pfx|

Browse...

Mote: Mare than one certificate can be stored in a single file in the following formats:
Perzonal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (.F7B)
Microsoft Serialized Certificate Store {55T)

Learn more about certificate file formats

<Back || Mext> cancel |

Password

To maintain security, the private key was protected with a password.

Type the password for the private key.

Password:

[] Enable strong private key protection. You wil be prompted every time the
private key is used by an application if you enable this option.

[ Mark this key as exportable. This wil allow you to back up or transport your
keys at a later time.

Indude all extended properties.

Learn more about protecting private keys

<Back [ Mext> Cancel

= —— —— ——

(- — S —

p-
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dadolususevdldnnseatnd (Digital Certificate)

-

=

ado Certificate yooussn

Certificate Import Wizard

)

Certificate Store

Certificate stores are system areas where certificates are kept,

Windows can automatically select a certificate store, or you can spedfy a location for
the certificate.

() Automatically select the certificate stor

@] on the type of certificate
@ Place all certificates in the following sto

Certificate store:
Browse‘a

Learn more about certificate stores

ri'l'

<Back | next> || cancel |

[ Select Certificate Store

2]

Certificate Import Wizard

Select the certificate

re you want to use.

=

] {71 Trusted Root Certification Authorities
t-{ | Enterprise Trust

-

E

- H |
-] Intermediate Certification Authorities
--{ ] Trusted Publishers

T lintrusted Cartifirates

i | *»

[ Show physical stores

Ok

Cancel

[ —

“Qaal. :

KUDBOIUKANAUSKISOAMISILA:S1UD8AIUE-aoNMOMSMAoUs:INANTUIAZoUAdBUACNSSUAINaN

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
(@) Place all certificates in the following store
Certificate store:

Personal

| Browse... I

Learn more about certificate stores

<Back || Next:q Cancel

(o)

g(u

U 2564”



dadolususevdldnnsatnd (Digital Certificate)

dado Certificate vooustn

- -
Certificate Import Wizard —— u B u

Certificate Import Wizard

Completing the Certificate Import
Wizard

E : | The certificate will be imparted after you dick Finish. @ The |rr1pt:|-rt was successful,

You have specified the following settings:

Certificate Store Selected by User E2gbhE]

File Mame Ci\Users\AIO\Deskh

4 1] >
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dadolususevdldnnsatnd (Digital Certificate)

asoodounisdady Certificate

F ™
Certificates e ——— ‘ u

Q http://edi.dft.go.th/check_certificate.aspx P~
File Edit View Favorites Tools Help Intended purpose: [w:, v]
Internet Options m
- Personal | Other People | Intermediate Certification Authorities | Trusted Root Certification ¢ | *
| Securit 1 ~ | content Connections | Programs I Advanced |
Family Safety Issued To Issued By Expiratio...  Friendly Name
| Contral the Internet content that can @Famihr Safety 54 NEW TECHMOLOGY... CAT Root CA 5202012  MEW TECHNOLQ...
be viewed. |
Certificates |
Use certificates for encrypted connections and identification. f
o, |
Clear 551 2 _ Certificates I [ Publishers ]
AutoComplete
= = AutoComplete stores previous entries |
3 on webpages and suggests matches ]
for you, i
Feeds and Web Slices i
Feeds and Web Slices provide updated Impoart... ] [ Export... ] [ Remowve
@q\ content from websites that can be M
read in Internet Explorer and other I X ) [
programs. 1 Certificate intended purposes "
|| <All= ||
t
| I View ||
|| || |
H
: Learn more about certificates Close
I

— P

ok || cancel ][ meoy |
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@ http:/fedidft.go.th/check_certificate.aspx = & || Search.. P | T i@

10alusunsu Internet Explorer O oigta sgnatwreveme %[5

~
= ~ Anda(Setup) asadau(Verify) wadau(Test)
1ig13ulsd : s

wsyanau Digital Certificate:

http://edi.dft.go.th/check_certificate.aspx e
\/ gsSDHo0dd0U (\/e r'l fy) ldwmaididaaBuasui¥natuiiua Digital Certificate

Laﬂﬂiﬁ'1ﬁ1FjLi‘lﬂﬂ’1ﬁ(TEXId):| || Check |

maqnmaﬁaun‘vmaaa Digital Certificate uazTilsunsu Plug in
ii'm!n.lmanuuaﬁ'nalanusaunaﬁ(mgltal Signature)

‘li:'l.lﬁil'l.l HansasIAdau

- e e P - = .
1. ms@rdaTisunsy Plug in dwiuasanailatiaddnmsaiing © sadazousanud
2. msAMuAAN Security Settings - Trusted site zone @ w3u Internet Explore @ gadadnusannas {L—,g-;ﬁ"u 1.0.34)

3. misémdatuiusasdianmsaiing(Digital Certificate) © fadrzausanuan (Serial No. 0c06a95dcad7446f)

Ananuai (] Wi HuASRTIAEIY @ winaie isunmsasagaay ’!
¥

sieandaalususasdainusaiing(Digital Certificate) Adadaly

HmEEn: - INFORMATION CO. LTD"

\aurLEDANE:

Serial No: 0co6 46f

Juiaanludusaa: Thursday, June 6, 2019

Fudinuaans: Sunday, June 6, 2021

AnTuL: xuledné - dalaivuaang

il Private Key: true

Subject: C:'[H, LZN-ONTHABURI, o=" » INFORMATION CO. LTD", .
OU=TAXID: , CN= INFORMATION CO.,LTD" E=

Issue By: C=TH, O=TOT Public Company Limited, CN=TOTROOTCA
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. O
*

@ @ hitp://edi.dft.go.th/check_certificate.aspx = & || Search.. o~ 1§ B
/ n O ao U (Te St) Q dayamstusssaimuduadae Dig.. @ Digital Signature Demo x |[F

o e

Digital Signature - Client

P - . - . PP S | - . x> oalg w i e
dmwmiunsasanaiiafiadiannsaiing aaa Certificate 'I.ﬂFlﬂﬂmﬁm-ﬂ'l."lLﬂ‘iEl\'JF‘IEIJ.I“’JLﬁﬂ‘i‘ll‘r}\l#j-‘ﬁﬂ"lu“i'lfﬂd‘llﬂl‘.!ﬂ

lawlsrdnd@didnans(TaxId): - FuvTtiaya Certificate sanfdvann Tadd (wugidnad)
String Data:

Data for Sign. fayanagau

2
gt
A
[ric]
[274]

G

waasussanufiadofifnusatind(Sign) | 9 Message from webpage X

Result:

MIINIAY JKoZIhveNAQcColINETCCDQOCAQEXCZAJBgUDgMC GgUAMASGCSqGSIbID| /1 OF: Verified ADAGECAgh3pSigubx1PzANBgkqhkiGIw0BAQIFADBGMQswCQYDV
QQGEwJUSDEMCEGA1UECgwaVESUIFB1YmxpYyBDb2 1wYWS5IExpb\WIOZWQxEAQ TAeFw0xNZEwMTEWNDIONTFaFw0zNzEwMTExMDAWMDBaMEYx A
CzAJBgNVBAY TARIMSMwIQYDVQQKDBpUT1QgUHVibGHIENVbXBhbnkgT GitaXRIZDE ENBMIICI/ANBgkghkiGIwDBAQEFAAOCAGBAMIICCgKCAgEALM4
NiSEbQ/dSFWCYLIEShyhNteWVSY56YpMG2BhUPYjbH8cabYQvE gekK4caS8I0Ch Y Adlo] pREGtKjpFBIbCmsCBxij2FmNf7/oyh1labgkJE GuNDOHXh5LOjfVEPu
DvlkeJSDPcs9cQhJclOiBOS/Y Typ1imXBQrePANGnClSWE4+hF09nz0KFEPzixCrlPJzvUcu eMv3sVOkgzMQWsshmoPFxiWbKOmlySv THBbvL Acti0skCaKulBhyg5
IXZn5EY GJKMOSE +tyHhH321bhpzs03sqdgMCckRPW/0QOAPeepoTKVQgHY T QL m+ hAIL5uL H+mUmfF|+O4NTNr3iwgv36mLFdzCXCrSjwBSYwG186vQhkiL
QYQ3w+7bdamnj009p/RVITWIZCIUBSpCb4ST0j586Qy2FNugcpQBMV2dWonM2P6+H3H3KkDK Ty chyMFUV+H/eIDRCIng+hSVaj2eORFibftgllhJnbAF GZWYHNdfmJULobL FNBc1v29zfeki113h
dHgSr8dwhkyDtmFuEGccdSDnogY1ZC911g3FigL TBOnhaf+ ToNj9PtORasqVVqnTzS8ywOUctdm237 C1KT2EECAWEAAANMGEwWHQYDVROCEBY EFKBumUpuEKvcWawJtNmajznYegkoMAS
GATUJEWEB/WQFMANBAfBwHWYDVROjBBgwFoAU0G6ZSmA4QqSxaq8m02ZqPOdh6CSgwDgYDVRIPAQH/BAQDAGGGMAIGCSqGSIb3DQEBDQUAAMICAQCISmRhdzvibzZxodddbYClg v
B8GCMZTrU2SFb5LgHKyh3kkFDsgx2182181GoJMLi6d5zleHVmzvxViNglunQze34Y1G6TadZRZYPqbaxiUBCcAPza/ OdvwYfLaH+Aci8P2JB/dHGV3R4NVQI3Anz5wksoxah3sigDdZILIshIViFyys/

ssaaouaafiadofiinvsofind(Verify) | e w

©2013 NTi. All rights reserved

] e " - . - s ol al
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